LESSON 1

1.1

Understanding
Databases

After completing this lesson, you will be able to:

Start Access and open an existing database.
Move around in Access.

Open and close a table.

View a table in Datasheet view and Design view.

Navigate within a table using the mouse pointer.

Navigate within a table using the keyboard.

Important: When you open a
file in Access, you might see
a Security Warning dialog
box that states that the file
may be unsafe. Access
displays this warning to make
sure that the file you are
about to open is from a
trusted or known source. If
you should see this warning
when attempting to open
practice files for any of the
lessons, click Open to close
the Security Warning dialog
box and open the practice
file.

A database is collection of data, or information, that is organized so that specific
information can be easily located and retrieved. The phone book is an example of a
noncomputerized database. The phone book contains names, addresses, and telephone
numbers arranged alphabetically by last name so that it is easy to locate information for
a particular person.

Microsoft Access is a database management system (DBMS) for creating and using
computerized databases. A database management system is an integrated collection of
programs that are used to create and manage information in a database. Computerized
databases are much more powerful than noncomputer-ized databases (like the phone
book) because users can reorganize data and search for information in hundreds of
ways. For example, if a phone book were stored as an Access database, you could
search by address, first name, or phone number, instead of just by last name.

As another example of the advantages of computerized databases, consider Adventure
Works, a fictitious outdoor vacation resort outside Santa Barbara, California. The
marketing manager for the resort wants to send a summer events newsletter to
everybody who has visited the resort during summer months within the past five years.
If the records for guest visits were kept in ledger books, you would need to flip through
the books page by page to create a list of past summer visitors. With a computerized
database, however, you could create a list of previous summer visitors in seconds. If
the marketing manager later decides to send a newsletter to winter visitors instead, a
computerized database could create this new list almost instantly.

To complete the procedures in this lesson, you will need to use a file named Database
Fundamentals 01 in the Database Fundamentals Practice folder that is located on your
hard disk. This database tracks employees, human resources information, guests,
reservations, and suite information for the fictional Adventure Works.
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tip
For maximum compatibility with existing databases, the default format for new
databases created with Access 2002 is Access 2000.

You can also open an
existing database by finding
the file on your hard disk and
double-clicking the file name.
Access and the database will
open at the same time.

When you open an Access
2002 database, you may see
an introductory screen, called
a splash screen. Close this
screen. A switchboard screen
may then appear, and if you
close that screen, the
Database window will
appear.

If Access is already open,
you can open an existing
database by clicking the
Open button on the Database
toolbar and navigating to and
selecting the desired file.

Starting Access and Opening an Existing
Database

You start Access by clicking the Start button on the Windows taskbar, pointing to
Programs, and clicking Microsoft Access. As with other Microsoft Office applications,
Access has a menu bar and one or more toolbars across the top of the window, as
shown in the following figure. New to programs in Microsoft Office XP is the task
pane shown at the right side of this window. In Access, a different version of the task
pane appears when you click either New or Search on the File menu, or click Office
Clipboard on the Edit menu. From the task pane, the toolbar, or the File menu, you can
choose whether to create a new database or open an existing database.
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If you have recently worked with the database to be opened, it may be listed in the top
section of the task pane in the Open a file section. If so, click on the file name to open
the database. If your database is not listed among the most recently opened files, click
the More files link at the bottom of the list. This will open a dialog box from which
you can navigate your disk drives to find the file and open it.

After you’ve opened the database, a separate window, called the Database window,
appears below the menu bar and toolbar. The Database window is used to navigate in
Access.

In this exercise, you start Access and open the Database Fundamentals 01 database.
1 On the Windows taskbar, click the Start button.

2 On the Start menu, point to Programs, and click Microsoft Access.

3 Access starts, and the task pane appears on the right side of the screen.
4

Click the More files link near the top of the task pane. The Open dialog box
appears.
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5 Click the Look In down arrow, click the icon for your hard disk, and then
double-click the Unlimited Potential folder.

6 Double-click the Database Fundamentals Practice folder. The Open
dialog box displays a list of files stored in the Database Fundamentals
Practice folder, with Database Fundamentals 01 already selected.

7 Click Open.

The Database window for Database Fundamentals 01 appears.

You can choose from a
variety of different Office
Assistant characters. Right-
click the Office Assistant, and
click Choose Assistant. You
might need to insert the
Microsoft Office 2002 CD or
the Microsoft Access 2002
CD to install the Office
Assistant character that you
choose.

About The Office Assistant

The Office Assistant is an animated character that helps you find answers to questions
that you might have about Access. The first time that you start Access, the Office
Assistant appears. You can also display the Office Assistant at any time by clicking
Show the Office Assistant on the Help menu. When you need help with a particular
feature, ask the Office Assistant a specific question, and a list of possible answers will
appear.

The Office Assistant is available in all Microsoft Office programs, but it provides
answers specific to the program that you are using when you ask the question. For
example, if you are working in Access and ask the Office Assistant a question, it will
give an Access-specific answer, but if you are working in Microsoft Word and ask the
Office Assistant a question, it will give a Word-specific answer.

The Office Assistant displays help information at your request, but it tries to stay out of
your way the rest of the time by moving to another part of the screen whenever it is in
the way of your insertion point or your typing. You can close the Office Assistant at
any time by clicking Hide the Office Assistant on the Help menu.




You can switch to the
Database window from any
other window in Access by
pressing F11. The vertical
arrangement of the Objects
bar makes it easier to use.

When referring to the
individual fields in a record,
the words cell and field can
be used interchangeably.
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Moving Around in Access

When you opened the Database Fundamentals 01 database in the previous exercise, the
Database window appeared on your screen. The Database window toolbar appears
along the top of the Database window and contains the Open button, Design button,
New button, Delete button, and options for displaying the items listed in the Database
window.

The Objects bar and Groups bar appear along the left side of the Database window.
The Objects bar includes the part of the Database window under the word Objects.
Object is a generic term that refers to any component of an Access database. The
Objects bar lists the major types of objects in an Access database: tables, queries,
forms, reports, pages, macros, and modules.
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The foundation for all other types of objects in Access is the table, because tables store
the data that the other objects use to perform procedures and activities in Access. A
table is made up of fields and records that are displayed in a row-and-column format
with fields as the columns and records as the rows. A field can contain data about a
person, place, product or service, event, or other entity. For example, a field would
contain all the last names or phone numbers in a table. Each field in a table has a field
name, also called a label, which appears at the top of the column. For example, a field
that holds all the last names for the guests at Adventure Works could be called
LastName.

A collection of related fields forms a record. For example, a resort guest’s FirstName,
LastName, Address, City, State, and PostalCode fields might make up a single guest
record, as shown in the following illustration. In this book, the intersection of a record
(row) and a field (column) is called a cell.

B thiGuests : Table

GuestlD FirstMame LastMame Address City State PostalC «
i3 1 Tom Getzinger 1000 Jefferson Denver co 90421
- 2 Robin Hjellen 2345 23rd Avenue Las Vegas I 10032
- 3/ John Chen 234 5 Dakota Santa Fe MM 24312
- 4 Garth Fort 7204 YW, Florida San Francisco | CA 82331
| 5 Shelly Szymanski B21 Washington Way Boulder co 44565
| 6 Louise Margan 9959 5. 43rd Avenue Pala Alta CA 34554
| 7 Karen Khanna 3406 Y. Srd Ave. Eugene OR 22393
| 8 Meng FPhua 89013 Kentucky Miarmi Beach |FL 17686 -
Record: 14| <[ 1w [ M[pk|of 48 «| | L[J




Queries are explained in
more depth in Lesson 4,
“Creating and Using
Queries.”

Forms are explained in more
depth in Lesson 5,
“Designing a Form.”
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Tables store all the information in a database, but if you want to view only selected
fields and records in the database, you use a query. A query extracts specific data from
one or more tables based on search criteria. For example, you could create a query for
the reservations table for Adventure Works to only list records for guests who have
made reservations after June 2000. The query might list each guest’s identification
number (or guest ID), reservation dates, number of occupants, and reserved room
number.

Another way to view information in a database is to use a form, as shown in the
illustration. A form displays a single record at a time in a specified format. Forms can
also be used to add new information to a database.

B frmEmployees

b EmployeelD “ml
FirztH ame |Ma:-c
Lasth ame |Bensu:un
Addresz ‘?44 E. Elm Cowrt
City [Wentura
State |E.-i'-.
PostalCode a0z03
HaomePhone |[BI]5] REE0110
Record: 14 | 1 k| M [ of 25




Reports are explained in
more depth in Lesson 6,
“Designing a Report.”
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If you want to display or print the data from a table or query, you can also create a
report. Unlike a form, a report can be used to display multiple records. Although this
sounds similar to a table, a report can be formatted in different ways to make the
information easier to use and more attractive than a table. For example, you could
create a report that contains a formatted title, a header or footer, and an attractive
background. Reports, like queries, can also be customized to show data from only
specific fields in a table instead of from all fields.

The Groups bar contains
groups of shortcuts to objects
of different types.

You can use the shortcuts in
the Database window to
create new objects with a
wizard or in Design view.

tblIEmployees
EmployeelD FirsiName LasiName  Address City State PostalC HomePhone Notes
M1 Lisa Jacchson S0 Lincoln Sarta Bathara  C4 004 (B05) 555-0101
M212 Megan Sherman 33 5. Broadway Sarta Bahara 4 a0z (B05) 555-0107
344 Suki White 1214 Elm Circle Sarta Bahara 4 a0a01 (B05) 555-0198  Graduatec
Arts of H
F455 Sue Jackson 2] Bwalway El Suero Ca 0015 (B05) 555-0138
3503 Frank Lae 1243 8%th Avere Sarta Bathara  C4 an0l4 (B05) 5550113
1304 Foger Hami 200 2nd At B Samta Bathara C4 0453 (805) 555-0172
305 S tephanie EBoime 1210057, 17k Samta Bathara C4 0453 (805) 555-0129
-
Page: [ 1 »|m ﬂ | LH

Besides tables, queries, reports, and forms, the Objects bar also includes these three
types of objects:

Pages. A page object is a shortcut to a data access page in a database. A
data access page displays selected data from a database, but it is an
HTML (Hypertext Markup Language) file that can be displayed as a Web

page.
Macros. A macro is a sequence of actions that are performed automatically.

Modules. A module is a program written in Microsoft Visual Basic or another
programming language.

When you click the icon for a particular type of object on the Objects bar, Access
displays a list of the names of all objects of that type in the database. (Fields and
records don’t have their own icons because they are not objects; fields and records are
stored within tables, which are objects.)

The Groups bar is located under the word Groups in the Database window and contains
one or more groups. A group holds a list of shortcuts to different types of objects in
the database. A shortcut is a quick way to get to an object stored somewhere else in
the database. The object shortcut is stored in the group, while the object itself is stored
in the appropriate list on the Objects bar. Groups allow you to keep related objects of
different types together. For example, you could create a group that holds shortcuts to
all the objects in the database that relate to the guests at Adventure Works, such as the
table that lists reservation information, the query that extracts reservations for the
coming week, and the form that allows you to enter new guest information. On the
Groups bar, the Favorites group is created by default and contains the names of the
most frequently used objects in a database.

In this exercise, you use the Objects bar to view different types of objects in the
Database Fundamentals 01 database.

1 On the Objects bar, click Tables, if necessary.



There are no shortcuts to
create macros or modules.
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The names of the tables in Database Fundamentals 01 appear, along with
options to Create table in Design view, Create table by using wizard, and
Create table by entering data.

2 On the Objects bar, click Queries.

The options to Create query in Design view and Create query by using
wizard appear. There are no queries in the Database Fundamentals 01
database.

3 On the Objects bar, click Forms.

One form name, frmEmployees, appears, along with the options to Create
form in Design view and Create form by using wizard.

4  On the Objects bar, click Reports.

The options to Create report in Design view and Create report by using
wizard appear. There are no reports in the Database Fundamentals 01
database.

5  On the Objects bar, click Pages.

The options to Create data access page in Design view, Create data
access page by using wizard, and Edit Web page that already exists
appear. There are no pages in the Database Fundamentals 01 database.

6 On the Objects bar, click Macros.

There are no macros in the Database Fundamentals 01 database.

7 On the Objects bar, click Modules.

There are no modules in the Database Fundamentals 01 database.
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About Object Naming Conventions

As you navigated through the database in the previous exercise, you probably noticed
that the names of the objects followed a standard convention. The file names used in
this course follow the Leszynski naming convention, which was developed by Access
expert and author Stan Leszynski to encourage a standard for naming database objects.
The Leszynski naming convention also makes it easier to convert objects to formats
used by other database management systems without a loss of data or data
organization.

This convention requires each object to be identified by including the object type in the
object name. This way, you can tell at a glance whether an object is a table, query,
form, or other type of object. The following table identifies the naming prefixes that
are used for each type of object.

Object | Prefix
table tbl

form frm
query qry
report rpt

The Leszynski naming convention extends to field names, pictures, and all objects used
in Access, but only the prefixes listed above are used in this book. Following the
Leszynski naming convention:

The first three letters of an object name are lowercase and identify the object
type.

The name that follows the object prefix begins with a capital letter.
Spaces are never used in object names.

Object names contain only letters and numbers.

All Access objects (such as
tables, queries, forms, and
reports) can be opened in
Design view and are
generally created in this view.

Understanding Datasheet View and
Design View

Every Access object has two or more views. Tables are most commonly viewed in one
of two formats, or views: Datasheet view and Design view. You switch between the
two views by clicking the View button on the Table Design and Table Datasheet
toolbars. You can choose other views by clicking the down arrow to the right of the
View button and selecting a view from the drop-down list.

Design view allows you to design the structure of a table by deciding what fields will
appear in the table, customizing the process of entering data into the fields, and
determining how the data will appear to users. The Adventure Works database includes
tbIEmployees, a table that contains basic information, such as addresses and phone
numbers, about the resort’s employees. Here is tblIEmployees in Design view:
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# thlEmployees : Table

Field Mame Data Type
10 Text
FirstMame Text

Cescripkion

LastMame Text
Address Text
Ciky Text
Skate Text
PostalCode Text
HomePhone Text
Notes IMemo I
Field Properties
General l Lookup ]
Field Size 50
Formak
Input Mask,
Caption
Default Yalue A Field name can be
‘alidation Rule Hp I:;'Ijj;"‘ig:li':j‘?;;ers
Walidation Text spa-:es.J Press F1 for
Required Mo help on field names.
Allow Zero Length Mo
Indexed ‘Yes (Mo Duplicates)
Unicode Compression Mo
IME Maode Mo Contral
IME Sentence Mode Mane

Using Design view to create The Field Name column contains the names of the fields in the table. The Data Type
and modify tables is column allows you to decide what kind of data (for example, alphabetical or
explained further in Lesson 2, numerical) can be entered into a field. The lower part of the Table Design view
“Creating Tables.” . . .

window allows you to set specific properties for each field.
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When you display the table in Datasheet view, the actual data in the table appears. For
example, in tblIEmployees, the field names, displayed in the Field Name column in
Design view, appear from left to right across the top of the table.

The data in some of the fields B thlEmployees : Table

may be partially cut off. This -

is because Access does not EmployeelD | FirstMame LastMame Address 4 -

aUtomatéca"y adjust column AiH101 EY: Benson 744 E. Elm Court W

widths. Changing column . ]

widths is discussed in Lesson H102 Sandra Mgrtmez 2080 W, 104th o

4, “Creating and Using H103 Sregary Erickson Y 5. Dak S

Queries.” H104 Judy Leny 555 hain Street Qj
hA201 Lisa Jacobsaon 90 Lincaln o
h202 otephanie | Conray 123 M. Dak e
k203 Steve Alboucy 5E93 Main Street o
k204 Kathryn YWilson 243 Syracuse G

205 Ray Lambroski 247 %Y, 29th Awenue | 3

h205 Sean Chai 995 Pearl 0w
Fecord: 14 | 1 kM |Hi%| of Zg 1 »
In this exercise, you open tblGuests in Datasheet view, switch to Design view, and then
switch back to Datasheet view.
1 On the Objects bar, click Tables.

2 Click tblGuests.
Access selects the table.

You can also double-click a 3 On the Database window toolbar, click Open.

table name to open it in The table appears in Datasheet view.
Datasheet view.

& thiGuests : Table

GuestlD FirstName LastMame Address City State Posta =
i3 b o Getzinger 1000 Jefferson Denver co 0421
- 2 Rohin Hjellen 2345 23rd Avenue Las Wegas M 10032
- 3 John Chen 234 5. Dakata Santa Fe Tk 24312
- 4 Garth Fort 7204 V. Florida San Francisco |CA 82331 |
- 5 Shelly Szymanski B21 Washington YWay Boulder co 44565
- B Louise targan 959 5. 43rd Avenue Palo Alto CA 34554
- 7 Karen khanna 3406 W, 3rd Ave Eugene OR 22358
- 8 Meng Phua 89013 Kentucky Miarni Beach | FL 17686
- 9 Michelle “otova 300 5. University Los Angeles CA 76756
- 10 Jahn tlaffei 3394 Lincaln Dr. Spokane WA 23477
- 11 Darlene Rudd G103 Adams Austin TH 80323
- 12 Kim ‘foshida 9395 First Avenue Sante Fe Tk 20102
- 13 Raob Young 72834 5. Florida Place Salt Lake City |UT 07085
- 14 James Wilson 8723 14th Ave Carson City i 12933
- 15 Steve DeBroux 3422 E. Bth Ave Phaoenix AL B7651
- 16 Ted Bremer 99455 5. Wyoming P Boulder co 22349
- 17 Jay Henningsen 1506 5. Colorado Ave. Allbany MY 26458 «
Record: M| [T 1 b [ M| ef 49 <« LI_‘




To open a table in Design
view, click the table name,
and click the Design button
on the Database window
toolbar. When you switch
between Datasheet view and
Design view, the picture on
the View button changes to
show which view the object
will appear in after the button
is clicked.
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4 On the Table Datasheet toolbar, click the View button.
The table appears in Design view.

B tblGuests : Table

| Field Marne Data Type Description ~
KL ) AutoMumber =
| |Firsthame Text =
| |Lasthame Text

| |Address Text

|| Cikyw Text

| |State Text

| |PostalCode Text

|| MailingList Yesiho

| A

Field Propetties

General ] Lookup ]

Field Size Long Integer

New Walues Increment

Farmat

Capion & field name can
Indexed Wes (Mo Duplicates) be up ko 64

characters long,
including spaces,
Press F1 far help

on field names.

5 On the Table Design toolbar, click the View button.
The table appears in Datasheet view.

To open or close a toolbar,
you can right-click any
toolbar and click the name of
the toolbar that you want to
open or close on the menu
that appears.

About Toolbars

Depending on the object being viewed, the toolbar located at the top of the Access
window has a different name and contains different buttons. For example, when
working with a table in Design view, the toolbar is named the Table Design toolbar.
When the table is displayed in Datasheet view, the toolbar is called the Table Datasheet
toolbar. If no objects are open, the toolbar is just the Database toolbar.

To find the name of the toolbar, you can right-click it. On the menu that appears, the
name with the check mark in front of it is the name of the toolbar.

Microsoft Access

File Edit View Insert Tools ‘Window  Help

Dy SAV & - ©
Database
Formatting {Datasheet)

Task Pane

Wweb

Customize, ..

Except for the Database toolbar, all Access toolbars contain the View, Save, Cut,
Copy, Paste, and Microsoft Access Help buttons. Each toolbar also contains buttons
specific to that toolbar.




The number of records that
you can view at a time
depends on your monitor
size, screen resolution, and
the size of the table window.
A 15-inch monitor set to 800
_ 600 resolution can display
about 25 records.
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Using the Mouse Pointer to Navigate in
Datasheet View

Many databases contain large tables that, when opened, do not fit on your screen. For
example, when you opened tblGuests in the last exercise, only the information for
about the first 25 guest records appeared on your screen, depending on the size of your
monitor and view window. To view the last record, which is number 49, you might
have to navigate down through the table to show the record on your screen. To edit and
view all the data in a database, you need to know how to move around within a table.

In Datasheet view, you can use the mouse pointer to select a cell for editing simply by
clicking the cell that you want to select. Using the mouse pointer is often the fastest
way to navigate if the cell that you want to edit is visible on the screen, and if it is not
close to the currently selected cell. You can also use the mouse pointer in conjunction
with the scroll bars to move to parts of the table not visible on the screen. You can
either drag the scroll boxes within the scroll bars or click the scroll arrows.

tip

In Datasheet view, Access supports two general viewing modes for a table: Edit
mode and Navigation mode. \When you open a table, it is in Navigation mode. In
Navigation mode, you can navigate within the table, allowing you to view data
easily. When the data in an entire cell is selected, Access is in Navigation mode. In
Edit mode, as the name suggests, you can navigate within a cell in the table and
edit individual characters in the cell. When a blinking insertion point appears in the
cell, Access is in Edit mode. To switch between Navigation mode and Edit mode,
press F2.

Another way to navigate within a table is to use the navigation buttons in the bottom-
left corner of a table.

15 Steve DeBrousx
16 Ted Brerner

17| Jay Henningsen
18 Anas Abbar

Record: 14 | 1 k| M (k3] of 49

The navigation buttons are described in the following table.

Click the To select the
First Record button First record in the table.
Previous Record button Previous record (for example, to go from the

tenth to the ninth record).

Next Record button Next record (for example, to go from the tenth
record to the eleventh record).

Last Record button Final record in the table.

New Record button First blank record after the final record in the
table so that you can enter a new record.

You can move the insertion
point to the Specific Record
box by pressing F5.

Additionally, typing a number in the Specific Record box moves the insertion point to
that record. For example, if you type 3, the insertion point will move to the fifth record.
This is useful in very large tables when you don’t want to spend a lot of time clicking
buttons to get to the record that you want.




The total number of records
in the table appears to the
right of the navigation
buttons. In the table shown
here, there are 49 records.
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In this exercise, you use the mouse pointer to select a cell in tblGuests, and then you
use the navigation buttons and scroll bars to navigate to different locations within the
table.

1 In the Address field of the first record, click between 1000 and Jefferson.
The insertion point appears in the field.

2 On the scroll bar on the right side of the table, drag the scroll box down
until the record for guest ID 49, Kim Ralls, is visible.

3 In the FirstName field, click after the word Kim.
The insertion point appears after the word Kim.

4 On the scroll bar at the bottom of the table, click the right scroll arrow
button until the MailingList field is visible, if necessary.
The table scrolls to the right.

# thlGuests : Table

LastMarne Address City State FPostalCode MailingList |~
| b | Getzinger 1000 Jefferson Denver co 80421
| [Hjellen 2345 23rd Avenue Las Wegas M 10032
| [Chen 234 5. Dakota Santa Fe TbA 24312
| |Fort 7204 W, Flarida San Francisco | CA 82331
| [Szymanski B21 Washington Way Boulder co 44565 O
| [Morgan 999 5. 43rd Avenue Pala Alta CA 34554
| [Khanna 3406 WY, 3rd Ave. Eugene OR 22358 0
| [Phua 89013 Kertucky Miarni Beach  FL 17686 O
|Yotova 300 5. University Los Angeles CA 76756
| Maffai 3394 Lincoln Dr. Spokane WA 23477
_|Rudd 6103 Adarmns Austin T 60323
| [Yoshida 9395 First Avenue Sante Fe TbA 20102
| [Young 72834 5. Florida Place Salt Lake City UT 07oss ]
- |Wilson 8723 14th Ave Carson City K1 12933
| [DeBraux 3422 E. th Ave Phoenix AL 67651
| |Bremer 99495 5. Wyoming Pl Boulder co 22349
___|Henningsen 1506 5. Colorado Ave Allbany MY 26498 O
| |Abbar 1233 W, Maine Albuguergue M 14143 j
Record: | 4 [[ 1 _p [Pk of 49 Kl | |




In tbiGuests, the records are
sorted in sequential order
based on the GuestID field.
Consequently, when you type
35 in the record number box,
the selected record is for
guest ID 35. But if the table
were sorted in a different
way, record number 35 would
probably not contain guest ID
35. For example, record
number 35 might contain
guest ID B206.

Notice that the GuestID field
remains the selected field as
you change from record to
record using the navigation
buttons.

1.14
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On the scroll bar at the bottom of the table, click the left scroll arrow button

until the GuestID field appears.
The table scrolls to the left.

In the GuestID field, click in the record for Kim Ralls.
The insertion point appears before the number 49.

Click in the Specific Record box, delete the existing number, type 35, and
then press Enter.

Access selects the GuestID field in record number 35.

B thiGuests : Table

EBEX

GuestlD FirstMarne LastMNarme Address City State -

id Williarn “ong 5526 W 11th Ave. Charleston sC
L 36 Pat Kirkland 1212 Morth 15th St Boise 1n]

L 37 Salman Mughal P.0. Box 573 Poughkeepsie | NY
L 35 Adam Stein 1283 3. daho Worcester hd
| 39 John Maffei 491 Lincaln San Francisco | CA
L 40 Laura Marman B18 Carter Lane Redwood City | CA
L 41 Doug Harnptan 46 Pennsylvania Avenue. Sante Fe M
L 42 Patricia Esack G04 w¥. Louisiana Garbenille CA
L 43 Luis Bonifaz 2514 Kennedy Ave. Las Vegas MY
| 44 Joanna Fuller 1515 92nd Dr. Boulder co
L 45 Ketan Dalal 86 Vermont Avenue Rapid City S0
L 46 Joe Huovrard 876 California Dr Cheyenne W
L 47 Garrett Wargas 55199 Jefferson Rd. Bangor ME
L 48 Taby Mixon 1161 Arizona Ave. Green Bay Rkl
| 49 Kim Ralls 703 Hoover Avenue Kula HI

(AutoNumber)

Record: 4] 4 35 1

N

Click the Previous Record button.
Access selects the GuestID field in record number 34.

Click the Next Record button.
Access selects the GuestID field in record number 35.

Click the Last Record button.
Access selects the GuestID field in record number 49.

=1 Loy i@ “4U 1 BHNayIraIE Fes s sames 1 & T

| 42 Patricia Esack a04 V. Louisiana Garbenille Ch
| 43 Luis Bonifaz 2514 Kennedy Ave Las Wegas MY
- 44| Joanna Fuller 1515 92nd Dr. Boulder ca
- 45 Ketan Dalal 86 Vermaont Avenue Rapid City SD
| 46 Joe Howrard 876 California Dr. Cheyenne WY 1
| 47| Garrett Wargas 65199 Jefferson Rd. Bangor ME
- 43 Toby Mixon 1161 Arizona Ave. Green Bay Wil
i3 Kim Ralls 703 Hoover Avenue Kula HI
# | (AutoMumber)
|Record: ] | a3 » | p1[p¥]|of 49 < | »

Click the First Record button.
Access selects the GuestID field in record number 1.
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Using the Keyboard to Navigate in
Datasheet View

You can also use the keyboard to navigate within a table by pressing keys called

shortcut keys on the keyboard. After you become proficient with the shortcut keys,

this approach can sometimes be a faster way to navigate than using the mouse.

The following shortcut keys can be used to navigate within a table:

Press To Move

Tab To the next field in the current record.

Enter To the next field.

Page Up Up by one screen, selecting a record farther up in the
table.

Page Down Down by one screen, selecting a record farther down in
the table.

Right arrow key To the next field in the current record.

Left arrow key

To the previous field.

Down arrow key

To the next record.

Up arrow key To the previous record.
Home To the first field of the current record.
End To the last field of the current record.

Ctrl+Down arrow

To the last record in the current field.

Ctrl+Up arrow

To the first record in the current field.

Ctrl+Home

To the first field of the first record.

Ctrl+Page Down

To the right by one screen, selecting a field farther right
in the table.

Ctrl+Page Up To the left by one screen, selecting a field farther left in
the table.

Ctrl+End To the last field of the last record.

Shift+Tab To the previous field.

In this exercise, you use shortcut keys to navigate in tblGuests.

1 With the GuestID field in the first record selected, press Tab.

Notice that the same field,
LastName, remains the
selected field as you press

DAan~nA

Access selects the FirstName field in the first record.

2 Press Enter.
Access selects the LastName field in the first record.

3 Press Page Down.

The table moves down one screen, causing Access to select a record
farther down in the table.

4 Press Page Up.
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The table moves up one screen, causing Access to select the first record.

5 Press the Right arrow key.
Access selects the Address field in the first record.

6 Press the Left arrow key.
Access selects the LastName field in the first record.

7 Press Shift+Tab.
Access selects the FirstName field in the first record.

8 Press the Down arrow key.
Access selects the FirstName field in the second record.

9 Press the Up arrow key.
Access selects the FirstName field in the first record.

10 Press End.
Access selects the MailingList field in the first record.

11 Press Home.
Access selects the GuestID field in the first record.

12 Press Ctrl+End
Access selects the MailingList field in the last record.

13 Press Ctrl+Home
Access selects the GuestlD field in the first record.
You can also close a table by clicking Close on the File menu.

14 Click the Close button in the top-right corner of thiGuests.
The table closes.

About Relational Databases

Access is a relational database application. With relational databases, you can
combine data from different tables. A relationship between multiple tables is created
by linking a field name in one table with a field name in one or more other tables.

Relational databases have many advantages—such as reducing the time it takes to type
the data and reducing the amount of disk space needed—because information can be
stored in only one table instead of in multiple tables. Relational databases are also
faster to update because outdated or incorrect information needs to be corrected in only
one table, instead of in several.

Lesson Wrap-Up

This lesson covered how to start Access, open an existing database, navigate in the
Database window, open and close a table, and navigate within a table.

If you are continuing to the next lesson:

Click the Close button in the top-right corner of the Database window.
The Database Fundamentals 01 database closes.

If you are not continuing to the next lesson:

To quit Access for now, click the Close button in the top-right corner of the
Access window.

Access and the Database Fundamentals 01 database close.
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Quick Quiz
How can you navigate to different objects in a database?
How do you start Access?
What is the Office Assistant?
Why are tables the foundation for all other database objects?
Why is it an advantage to be able to link tables in a relational database?
What are the three ways that you can navigate in a table in Access?

How do you view a list of all the names of forms in an Access database?
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What are the two available modes for a table in Datasheet view, and how
are they different?

9 How do you open a table in Design view?

10 How do you change your view of a table from Design view to Datasheet
view?

Putting It All Together

Exercise 1: On the Objects bar, click Forms, and open frmEmployees. Ask the Office
Assistant What is new in Access 20027, close the Office Assistant, and then close
frmEmployees.

Exercise 2: On the Objects bar, click Tables, and open tblIEmployees. Look at the
table in Design view and then in Datasheet view. Using the shortcut keys, navigate to
the last field of the last record. Using the Specific Record box, move to the 18th record.
Using the shortcut keys, move to the EmployeelD field in the 18th record. Using the
navigation buttons, move to the first record, and close the table.

Exercise 3: On the Objects bar, click Tables, and open tblReservations. Look at the
table in Design view and then in Datasheet view. After examining the fields defined for
this table, can you think of any other fields that would be useful in this table? Do you
see any fields that could be removed from this table without impacting the operation of
the resort?

Exercise 4: On the Objects bar, click Tables, and open tblReservations. Look at the
table in Datasheet view. Press the F11 key to access the Database window, and click on
the tblSuites table to open it. View this table in Datasheet view. Since Access is a
relational database, it is possible to link one table to another. Which field(s) would you
use to link the tblSuites table to the tbIReservations table to create a relationship
between these tables?

Exercise 5: This lesson showed you how toolbars can be turned on or off. Can you
think of any reasons why you would ever want to turn off a toolbar that is currently
displayed?



